Visualising structures using
Mercury
CCDC Virtual Workshop 2020 — Session 2

llaria Gimondi, Suzanna Ward, Yinka Olantunji-Ojo, Natalie Johnson, Eva Myers

November 2020



Learning outcomes for today

Familiarise yourself with the Mercury interface

Learn the basic options to visualise small molecule crystal
structures

Learn how to visualise the packing and symmetry of a structure
effectively

Learn how to create high resolution publication ready images of
your structures
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CSD Refcode -
XOPCAJ

CSD Refcodes L,

What is XOPCAJ?
« ACSD Refcode

« A database reference code
« Containing 6-8 characters
« Used to identify entries in the CSD

-

Refcode families
« The same substances are assigned the same 6 letter code plus an additional 2 numbers

* Polymorphs
« New determinations or re-refinements of the same substance
« Determinations at different temperatures/pressures
Stereoisomers or different solvates, co-crystals, etc are assigned different refcode families
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The CSD software e
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Mercury — Structure visualisation

With Mercury you can:

« Explore crystal structures, molecular
conformations, crystallographic
planes and simulated morphologies

« Generate high quality structural
Images for effective scientific
communication

» Output model files for 3D printing

« Analyse geometries, interactions and
the packing inside structures
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Mercury — first launched in 2001

| @

Style: ‘ Ball and Stick ﬂCuluur. | by Element ﬂ Picking Made: | Select |  Clear Measurements

a b & bt o' x xt oy yr oz oz+ [ x90 x+90 y 90 y+90 290 z+90 | & = | T zoom- zoom =+
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Options
I™ Packing H-Bond Defautt definition IV Show hydrogens
Short Contact < (sum of vdw radii) I~ Show cell axes
Resst [ Label atoms

|| Press the left mouse button and move the mouse to rotate the structure




Structure visualisation O e

« Symmetry elements

* Displacement ellipsoids etc.
 POV-Ray

* 3D printing
* Graph sets
* Movies




Show One: Mercury Demo

@ AABHTZ (P-1) - Mercury — O X

File Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help

Picking Mode: | Pick Atoms ~ | Clear Measurements IE‘Q @f |:| Show Labels for | All atoms with | Atom Label

Style: Balland Stick ™ Colour: | by Element or Suppression ™ Manage Styles... |Work ~ Atom selections: b

l:‘ Animate. .. Default view: |b R a b c a* b* & X- X+ y- y+ z- z+ %90 x+90 yS90 y+90 z90 z+90 & - | T zoom- zoom+ | Selectby SMARTS:|[d]
Structure Navigator & X
AABHTZ Find
Crystal Structures Spacegroup

AABHTZ P-1
AACANITO0 P21/c
AACANIT1 P21/c
AACFAZ Pbcn
AACFAZ10 Pbcn
AACMAL P21/c
AACMHX10 Pbca
AACRHA Pncm
AACRHC P-1
AACRUB Cc
AACRUBO1 C2/c
AADAMC P21/c
AADMPY P-1
AADMPY10  P-1

AADRIB P21
AAGAGGT10  P212121
Display Options 7 X AAGGAGT0 P21
Display Options
<< ==
[] pacns [_] Short Contact < (sum of vdW radii) Contacts... Showhycrogens || pepth cue _
I:‘ Asymmetric Unit I:‘ H- Bond Default definition I:‘ Show cell axes I:‘ Z-Clipping TrERlED
l:‘ Auto centre More Info v |:| Label atoms Stereo l:‘ Multiple Structures
Reset Powder... Structures...

Press the left mouse button and move the mouse to rotate the structure




The basics

* Left mouse button and move — allows you
to rotate structure

« Middle Mouse button and move — allows
you to move structure

* Right mouse button and move — allows
you to zoom in and out of structure

« Structure Navigator — Allows you to view
any structure in the CSD

Structure Navigator

Type in a refcode Find

Crystal Structures

AABHTZ
AACANND
AACANIT
AACFAZ
AACFAZ10
AACMAL
AACMHX10
AACRHA
AACRHC
AACRUB
AACRUBO1
AADAMC
AADMPY
AADMPY10
AADRIB
AAGAGG10
AAGGAG10

Spacegroup

P-1
P21/c
P21/c
Pbcn
Pbcn
P21/c
Pbca
Pncm
P-1
Cc
C2/c
P21/c
P-1
P-1
P21
P212121
P21

<<

==
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File Edit Selection
Ficking Mode: | Pick Atorr St:,.r|E5,

Style: | Capped Sticks =

[] Animate...

Display Options

Display

[] Packing

[ ] Asymmetric Unit
|:| Auto centre

Reset

Display | Iculate CSD-Community CSD-System CSD-Materials

» easurements@@ EE; DShow Labels for | All atoms
Manage Styles... Work - | - Atom selections:
Labels
De b*® c* % ¥+ y- y+ z- z+ x90 x+90 y-90 y+90
Colours r . .
»" Display Options
Show/Hide 4

Mare Information g

Symmetry Elements...

Voids...

Graph Sets
Intermuolecular Potentials
Searches

Post Search Options

Display Options... |I

Structure Mavigator

Manage Styles...

Wiew along r

Dial box...

Splash screen

Toolbars

Picking Toolbar

Labels

Display

Style Manager Toolbar
Atom Selection Toolbar
Select by SMARTS
Animation Toolbar

Crystal Orientation Operations

AU N NN Y N N NN

Alignment and Crientation Operations

Options

[] Short Contact < (sum of vdW radii)
[] H-Bond Default definition

Show hydrogens [_] Depth cue

[ ] show cellaxes [ _] Z-Clipping
] Label atoms Stereo

Contacts...

More Info ~

Powder...

CSD-Discovery CSD Python APl Help

with Atom Label

7-90 7490 & = | T zoom- * | . Select by SMARTS: *

Structure Navigator g X

] Find

Crystal Structures Spacegroup ~

AABHTZ P41

AACANITO P21/c

AACANITT P21/c

AACFAZ Pbcn

AACFAZT0 Pbcn

AACMAL  P21/c

AACMHX10 Pbca

AACRHA  Pncm

AACRHC P41

AACRUB Cc

AACRUBOT C2/c

AADAMC  P2i/c

AADMPY  P-1

AADMPY10 P-1

AADRIB P21

AAGAGGT0 P212121

AAGGAGT0 P21

AALCFE P21/c

AALPRO P21/c

AAMAND  P212121

AAMTCO P

AAMTCO10 P-1

AAMTXP  P21/n

AANHOX  Pna2il

AANHOXO01 Pnalil

AAMOPM P21

AAPUNI P21/a W

< ==
Tree View

[] multiple Structures

Structures...

e I



File Edit Selection

Display lculate  CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help
Ficking Mode: | Pick Ator - Sty - "';”easm'ements@ ‘Q @i} (] show Labels for Al atoms with  Atom Label
es

Style: | Capped Sticks = Manage Styles... Work - | - Atom selections: -
[] Animate... | De Labels P ob = x x+ y oyt oz z+ | x00 x+90 y-00 y+00 z-00 z+90 & - L 1 zoom-  *  Select by SMARTS: »

Colours Structure Navigator 2 X

s Display Options
AACRUB Find
Show,/Hide
Graph Sets Crystal Structures Spacegroup ~
AABHTZ P

More Information Intermolecular Potentials AACANIT0 P21/c

AACANITT P21/c
Searches

Symmetry Elements... AACFAZ  Pben

Post Search Options AACFAZTO  Poen
Voids... AACMAL  P21/c
AACMHIX10 Pbca

Structure Navigator
AACRHA  Pncm

Display Options...

AACRHC  P-1
Manage Styles... AACRUB  Cc
AACRUBOT C2/c
AADAMC  P21/c
View along . AADMPY  P-1
AADMPY10 P-1
Dial box... AADRIB P21
AAGAGGT0 P212121
»" Splash screen AAGGAG10 P21

AALCFE P21/c
AALPRO P21/c
AAMAND  P212121

AAMTCO  P-1
AAMTCO10 P-1
Display Options q X
Display Options
[ ] Packing [ ] Short Contact < (sum of vdW radii) Contacts. .. Show hydrogens [_| Depth cue
[ ] Asymmetric Unit [ ] H-Bond Default definition I [ ] show cell axes [ ] Z-Clipping
[ ] Auto centre [ ] Label atoms Stereo | C D C
Powder...
Reset owder L !




Using your own file e

* File > Open —to open one of your own files for example a ClF
o Edit > Auto Edit Structure to assign bond types Auto Edt Manual
Guess bond types

* File > Auto Edit Structure on Load to automate O i

(® Only bonds with unknown types

& AABHTZ (P-1) - Mercury

File Edit Selection Display Calculate Edit Selection Display Calculate CSD-C
I DpEf‘I_._ Ctr|+D I Undo: PﬂCkiﬂg off Ctrl+7 Sg?]:ii;tlj;rs]es to Cambridge Structural Database
Recent Files 4 Redo: Not Available Ctrl+Y Aromatic bonds
Delocalised Bonds
Sketch Molecule... Ctrl+K Copy Image to Clipboard ~ Ctrl+C
Edit Structure...

Auto Edit Structure on Load

Auto Edit Structure...

Save As... Ct
POV-Ray Image...
Print in 3D...

Normalise Hydrogens... dd missing H atoms

Polymer Expansion...

Transform Molecules...

Apply | ‘ Close

Exit Ctrl+Q Change Spacegroup Setting...




Moving and rotating on the plane

With the keyboard:

CSD Refcode: GIMXUY

D



Right mouse click

Near a molecule

Selection
Styles
Colours
Labels
Show/Hide

Contacts

Delete this Molecule

Rotation Centre

IsoStar Interactions Check...

Measure

Clear Measurements

Packing

Selection

Styles
Colours
Labels

Show/Hide

Contacts
Picking Mode
View

Rotation Centre
New

Draw Backdrop

Display Options...

Away from a molecule

e I



Changing display - Style

Display Calculate CSD-Community CSD-System CSD-M

File Edit Selection Display Calculate C

_Picking Mode: Pick Atoms

Style:

Spacefill

. |E=:|I::|L

Styles 4 I Wireframe

Labels 4 Stick

Colours 4 Ball and stick

Show/Hide 4 Spacefill

More Information * Ellipsoid
Polyhedral

Symmetry Elements...

Voids Stick settings...

Display Options...
Manage Styles...

View along
Dial box...

v Splash screen

Toolbars

Ball and Stick settings...

Spacefill settings...
Ellipsoid settings...
Polyhedral settings...

Contact settings...

Measurement settings...

Selerted atnms

Animate...

r: by Element

ault view: b ~




Thermal Ellipsoids

* Anisotropic Displacement Parameters

» Only available for CSD structures with
ADPs

* Indicate thermal vibrations of atoms

» Size of ellipsoid is scaled

« Usually to probability of finding 50% of
electron density @ Ellipsoid Display Options

Probahility level (%6): |50 :

Display options

% Draw principal elipses, in colour: | 1N

Read more about
|:| Draw hydrogens as fixed-size spheres, of radius (A):

ADPs and Thermal
Ellipsoids in the
Dictionary on the
handout.

Draw Mon-Positive Definite atoms as cubes

b
0.30 +

Display Calculate CSD-Community CSD-System CSD-M

Styles
Labels
Colours
Show/Hide

More Information

SQummetny Flaments

CSD Refcode:
LORBAW

- hd h hd

Wireframe
Stick
Ball and stick

Spacefill
Ellipsoid
Polyhedral

Stick settings... .
Ball and Stick settings...

Spacefill settings... ~
/\

Ellipsoid settings... A

)y *
2o,

Polyhedral settings...



Manage Styles

» Pre-saved combinations of settings (styles, styles options, colou rs;

background colour, ...

File Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python

Picking Mode: | Pick Atoms v | Clear Measurements @ ﬂ) % [ ] Show Labels for All atoms
Style: | Ball and Stick ~ Colour: |by Element v . .
Manage Styles... |Publication ~
[ ] Animate..  Default view: b v  a b c a* L 90
. Work
I C X

Presentation

ORTEP
3D Print
Work 2

Cards

pre-saved
options

personalised
options

create your own
stylel

CCDC



Changing display - colours

Display Calculate

v

Styles »
Labels »
Colours »
Show/Hide »

More Information »

Symmetry Elements...

Voids...

Display Opticns...

Manage Styles...

View along »

hal box...

Splash screen

C5D-Community  C50-5ystem  C50-Matenals  C!

Atoms...
Bonds...
Centroids...
Planes...

Contacts...

Element colours...
Symmetry Equivalence colours...

Labels...

Background settings...

CSD Refcode: AACRURB

File Edit Selection Display

Picking Mode: Pick Atoms

Calculate CSD-Community

~ | Clear b

Style: Ball and Stick | ~ Colour:

[ ] Animate...

Default vie

by Element
by Element
i

trv eauivalence
by Atomic displacement
by Symmetry operation
by Gasteiger charge

by Partial charge

by Element or Suppression

-




Changing display - colours

@ CAKFAW (P21/n)

File Edit Selection

Picking Mode: Pick Atoms v | Clear Measurements @ ,O (E

- Mercury
Display Calculate CSD-Community CSD-System CSD-M

Style: Ball and Stick

 Colour: by Element or Suppression ~ = [Manage Styles... Card:

El Animate...

Default view: b villa b c a* b* ¢* X- X+ y- )

Disordered structures report two sets of
atomic coordinates: major and minor sites.
In Most cases the atoms of the minor site

will be suppressed.
Learn more in the Dictionary on the handout.

CSD Refcodes: CAKFAW and PIYDEI CC DC



Changing background colour

@ AABHTZ (P-1) - Mercury

File Edit Selection Display Calculate CSD-Con

Picking Mode: Pick At

Style: |Pﬂlyhedral

[]

Animate...

Styles
Labels
Colours
Show/Hide

More Information

Symmetry Elements...
Voids...

Display Options...
Manage Styles...

View along

Dial box...

Splash screen

Toolbars

r

3

4

@

o o}

0 Select Color

Basic colors

Custom colors

(] Display Options

Background
Depth Cueing
Labels
Lighting

Line

Stereo
Z-Clipping
Box-Clipping

(®) Single colour

() Gradient

HENT
L 0 1 1 I i
I ]
]
HEEEEENM]
EEEENCE
‘ Pick Screen Color ‘ |

X

Hue: [0 5| Red: [255 %

Sat: |D @| Green: |255 E”

I |

OOoOOooO val: [255 5| Blue: [255 3

‘ Add to Custom Colors ‘ HTML: |#ﬁﬁ’ﬁ ‘

| OK | ‘ Cancel ‘
- -
- —
Defaults
Close

D



File Edit Selection Display | Calculate CSD-Communitsp-Materials CSD-Discovery CSD Python APl Help

Picking Mode: | Pick Atoms @ [] show Labels for Al atoms

: Centroids... :
Style: Capped Sticks ~ (Colour: by E .‘k ¥ |- Atom selections: hd
|:| Animate... Default view: b PIHHES"_ y+ z- z+  x90 x+90 y-90 y+90 z-90
Packing/Slicing... Packing
Contacts... Show cell axes
Label cell axes
Molecular Shell...

Pack a:[ 0.0%/[ 1.0%

Graph Sets... I
b: 00+ 1.0+

Powder Pattern... | 002102

Structure Overlay...

Molecule Overlay...

Reset button:
a friend!

Display Options 8 x
Display Options
[] Packing D Short Ghntact < (sum of vdW radii) Contacts... [] Show hvdrogens [ | Depth |
[] Asymmetric Unit [] H-Bogd Default definition N [] show cell axes J[_] Z-Clippiiy
= E || Label atoms Stered
RE‘S Et Fowder...

with Atom Labe

z490 < = - T zoom- » | Select by SMARTS: »

CHrurtnien Masinatnr

+ 0.5

+ 0.5

+ 0.5

2X2%2

3x3x3

AW
Include atoms
() ... that Fit
(® ... in molecules whose Centroids fit

—

() ... in molecules where Any atom fits

() ... in molecules where All atoms fit

Structures...



Other display options

] T

V), 2, 000

Reset

Structure Information...

Formula C13 H12 Cl; Ng O3
C ical Di .
s e — c N 4-Acetoamido-3-(1-acetyl-2-
- ompound Name _ _
Atom List. robenzylidene)hydrazine)-1,2
Bond List... Centroids
Contacts List... Planes Synonym
Centroids List... Symmetry Space Group P-1
Planes List.. Cell Lengths a 11.372(9) b 10.272(5) ¢ 7.33
Symmetry Operator
Cell Angles a 108.75(6) B 71.07(4) y 96.1¢
Distances List... Torsibns
Angles List... Cell Volume 769.978
Torsions List... All Angles 7.7 Z:27Z"1
All Torsions

All Angles List...

All Torsions List...

VTSNoOW CEIl aXes
More Info ~ =

[ 11abel atoms

Display Options
Display Options
Packing D It ey Show hydrogens |:| Depth cue
Asymmetric Unit D H-Bon... Default definition | Show cell axes [ | Z-Clipping
|:| Auto centre D Label atoms Stereo

|

Click and drag left mouse button to zoom in.

-

10000.0

Current structure: AABHTZ

Save...

9000.0 1
8000.0 1
7000.0 1

000.0 1

%uoo.u 1
4000.0 1
3000.0 1
2000.0 1

1000.0 1

0.0° [
10.0

20.0 30.0
2 theta

Wavelength: 1.54056 29.952, -2040

Close

Save image...

L ©
i
<
* © .
L]
L
® X
X
-
- ®
» >
S
o o

40.0 50.0

hkl=112

CCDC
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File Edit Selection Display (
Open... Ctrl+O

Recent Files

Save As...

POV-Ray Image...

Printin 3D...

Ctrl+Q

Generating high quality images

Width (pixels) 4000 | Height (pixels) [3000

Material Properties ‘Standard Mercury " File Format PNG

Background ‘As Mercury " Custom Color

|:| Generate Animation Frames
Rotate around X y z

Number of Frames |30

File > POV-Ray Imae |
Change Resolution
Width = 4000

Preview || Render || Close

Height = 3000

Preview

Press Preview to generate image...

Settings

POV-Ray Executable }ovray—S.7.I}.I}fbinfpvengine.exe|
Qutput Directory |C:f Users/ward |

In order to run concurrent rendering or generate preview images
whilst a render is running, it is necessary to enable multiple
instances of POV-Ray. To set this uncheck the "Keep Single
Instance” option in the "Options" menu within the POV-Ray user
interface.

Change ‘Material
Properties’ to

‘Metallic’

Set ‘Background' to
Transparent’

Press ‘Preview

D




Previewing and rendering an image

Width (pixels) 14000

Material Properties Metallic ~ | File Format PNG

Background Transparent ~ | Custom Color
D Generate Animation Frames
Rotate around X W z
Number of Frames |30
Preview Render Close

Preview

Press Preview to generate image...

| Height (pixels) 3000

-

Width (pixels) 4000

Height (pixels)

Material Properties Metallic

Background Transparent

D Generate Animation Frames

Rotate around X Wy Z

Number of Frames 30

Preview

Preview

~ | File Format

~  Custom Color

Render

3000

PNG

Close

CCDC




Display - Options A

Display Calculate C5D-Comn LA AR .
Styles » 3 4 . | 1
Labels 4 v oy y
Colours » : . .
Show/Hide » v,
i »
iere nfermetien Background Light1  Light2  Light3  Light4
Depth Cueing
Symmetry Elements... . . .
Labels Diffuse colour: Specular colour:
- L Enabled =
Voids... Lighting Position: x: 1|y: 1|z 1
Line
I Display Options... I Stereo Ambient Light
Manage Styles... Z-Clipping Enabled Diffuse ambient colour: | .
Box-Clipping
View along » Defaults
Dial box... a
ose




«
) »
. % ’
g ...e
B b ® 1 '
° ‘e )
»
&9
- o
-
2
® °
@

CSD Refcode:
AABHTZ

D




Explore More: A selection of our Top Tips.
for Mercury

» Not enough time to explore all the things that Mercury can de.. '
* But here are a selection of advanced tips and tricks

* You can find more tips on social media with our
HCSDTopTipTuesday series

CCDC



Selection

Picking Mc
Style: Ball

D Anir

0 JEMSAW (P21/n) - Mercury

Select All

Select Molecules...
Select Atoms...
Select

Deselect All
Deselect Molecules...
Deselect Atoms...
Deselect

Invert Selection
Expand Selection

Save Current Selection...

— O X
File Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help
Ctrl+A |~ | Clear Measurements @p @} D Show Labels for All atoms with |Atom Label
R Manage Styles... Cards ~ | Atom selections: ~ | Select by SMARTS:|[c]

ol

3

Ctrl+D

Ctrl+1
Ctrl+E

a* h* c* v- v+ w- y+ z- z+ x-90 x+90 y-90 y+90 z-90 z+90 < > L T zoom- zoom+

Select Hydrogen

Select Non-Hydrogen
Select Carbons
Select Non-H, C

Select Metal Atoms
Select Non-Metal Atoms

Select Contact Atoms

Select Stereocentres

CSD Refcode:

JEMSAW

D




Visuali_ng hydrogen bonds

o » &
»

Display Options

Display Options
Packing Short ... < (sum of vdW radii) Contacts... v| Show hydrogens Depth cue
Asymmetric Unit |[/| H-Bon... Default definition o Show cell axes Z-Clipping
Auto centre Label atoms Stere
Powder...

Reset

Click on a red contact to see the whole molecule

e I



Turn on H-bond
INteractions using
the tick box

CSD Refcode: HXACAN

Eile Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help
Picking Mode: | Expand Contacts ~ | Clear Measurements @@ @\@ [ ] show Labels for All atoms with
Style: |Ball and Stick ~ Colour: by Element ~| . Manage Styles... Work ~ | Atom selections: @
[] Animate... Default view: |b I a b c a* b* c* X- X+ y- y+ z- z+ %900 x+90 y-90 y+90 z90 z+90 <« *
Structure Navigator g X
HXACAN Find
Crystal Structures ~ Spe ™
HXACAN  Pcal
HXACANO1T P21
HXACANO2 P21
HXACANO3 P21
HXACANO4 P21
T ANOS P21
Expand the H- ANOG P21
ANO7 P21
bonds by clicking Anos e
ANO09 P21
on the atoms at  Avera~
Display Options
Display the end of the >
[ ] packing adii) Contacts... d h d | .
[] Asymmetric Unit\{[/] H-Bon... Default definition | More Info_~ asne ines. ' Structures
D Auto centre ! || Label atoms Stereo TR
Powder...
Reset
Structure Navi... Sea...
Click on a red contact to see the whole molecule

e I



Building the H-bond network

By clicking on the
atoms at the end
of the dashed lines

CSD Refcode: HXACAN




Colour H-bonds by distance

@ HXACAN (Pcab) - Mercury — O X P

File Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help

Picking Mode:  Expand Styles » | |Clear Measurements @ Q % [ ] Show Labels for Stereocentres with |Stereochemistry

Style: Capped Sticks Labels ' ~ | Manaqe Styles... |Cards ~ | Atom selections: v Select by SMARTSZ‘[C]

[ ] Animate.. C Colours g Atoms... +  x-90 x+90 y-90 y+90 z-90 z+90 ¢ - L T zoom- zoom+
Show/Hide 4 Bonds...

More Information  * Centroids...
Planes...

Symmetry Elements...

Y M Contacts...

Voids...

Voids (Experimental)... Element colours..

Symmetry Equivalence colours...

Display Options...
PRI Labels...
0 Contact Colours X [S--
Background settings...
Contact Colours »

O By expanded/hanging

O Colour
select colour:

(® Colour by distance

short:  mid:
[ ]

long:
[

Apply to:

All Contacts

Expanded Contacts

Hanging Contacts

Close

P

CSD Refcode:
HXACAN

CCDC



Bonus: Graph Sets

o SALMIDOZ (12/a) - Mercury

Calculate  C5D-Community

Centraoids...

Planes...

Packing/Slicing...
Contacts...
Maolecular Shell...

Graph Sets..
Powder Pattern...

Structure Cverlay...

Malecule Overlay...

Graph Sets describe the

H-bonds pattern.
Learn more in the Dictionary
on the handout.

File Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python API
~ | Clear Measurements @ Q @} [] show Labels for All atoms
Manage Styles... |Cards

a b c a* b* c*

Picking Mode: |Pick Atoms
v | Select by SMARTS:|[c]
x-90 x+90 y-90 y+90 z90 z+90 ¢« > L T zoom-

Atom selections:

Style: Ball and Stick ~ Colour: by Element
[] Animate...

CSD Refcode: SALMIDO2

with [Atom Label

Structure Navigator

SALMIDO2

Crystal Structures
SALMID0Z2 12/a

<<

Tree View

[_] Multiple Structures

Graph Sets

descriptor

R2,2(8) »a>a

C1,1(6) b
S$1,1(6) ¢
2,2
2,2
C4,4

—_—

— = =

<

8) >a<b

10) >a>b

18) >a>b<a<h
R6,6(28) >a<b<b>a<b<b 2
R6,6(30) >a>b>b<a>b>b 2
R6,6(32) >a>b>b>a>b>b 2

[ I S e e




Adding, moving and sizing labels s

o & © .

@ ADECIWO1 (P21/9) - Mercury — O X - ,
-3

File FEdit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help ® e
Picking Mode: Move Labels v | Clear Measurements @Q @} Show Labels for Non C,H v ]ith Stereochemistry ~ o » T
Style; Ball and Stick  Colour: by Element v Manage Styles... Cards ~ - Atom selections: ~ | Select by SMARTS: [c] | x "
@ ADECIWO1 (P21/¢) - Mercury — O X v o g
File Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help "
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Labelling chiral molecules
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Calculating centroids
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Calculating and visualising planes

o WUTTEM (Pbca) - Mercury
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Empty space visualisation N
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Want to explore more?

Educational Resources

The wealth of information contained within the Cambridge Structural Database (CSD) extends far beyond a collection of crystal structures. Knowledge derived from these materials

CSD-System

Essential crystallographic and structural chemistry -

capabilities. =

Information on the Teaching Subset

Self-guided workshops
https://www.ccdc.cam.ac.uk/Co

m u n |t\//ed u C a t | O n a | reSO u rC eS/WO Download a series of self-guided workshop materials
. for CCDC tools and features
rkshop-materials/
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S Lo
2 =

Access fun science activities for kids through the
CCDC Home learning page

informs much of chemistry, biochemistry, and biclogy. Chemical and structural concepts are often difficult to grasp without real world, interactive examples for students to explore.

The CCDC and our colleagues continually produce educational materials for use in classroom and computer lab settings, or as independent study modules. Many of these materials
make use of the Teaching Subset - a freely available set of over 750 structures that can be investigated with the free version of our Mercury visualisation and analysis program. Of
course, our database of over one million entries are available for free through our Access Structures portal.

If you are an educator looking for supplementary teaching materials, find out more about the Teaching Database here. If you have developed your own modules using the CSD and
would like to share them with the broader community, please contact us at education@ccdc.cam.ac.uk.
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